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Getting Started with DME Designer

In this manual the abbreviation “DME” refers to the DMEG64N/DME24N/DMES8i-C/DME80o-C/DME4io-C/
DMES8I-ES/DME80-ES/DME4io-ES. The abbreviation “DME Satellite” refers to the DME8i-C/DME80o-C/
DME4io-C/DMES8i-ES/DME80o-ES/DME4io-ES.

Your DME, SP2060, ICP1 and the DME Designer software, let you build a custom audio system
installation that can support an incredible variety of conditions. You can build an entire system from
input to output with the DME Designer software, then send the system data to the DME and SP2060
which become independent processors.

An amazing variety of applications are possible, including audio installations, sub-mixing, speaker
system control, matrix/routing, and multi-effect processing.

Here the abbreviation “DME” does not include the “DME32.”

This manual is based on the English version of operating system. lllustrations, command names, window names, and similar
information are from that version. Some items may differ from what you see on the computer screen, depending on which
operating system you are using.

SPECIAL NOTICES

e The software and this Owner’s Manual are the exclusive copyrights of Yamaha Corporation.
e Copying of the software or reproduction of this manual in whole or in part by any means is
expressly forbidden without the written consent of the manufacturer.

* Yamaha makes no representations or warranties with regard to the use of the software and
documentation and cannot be held responsible for the results of the use of this manual and the
software.

e The company names and product names in this Owner’'s Manual are the trademarks or registered
trademarks of their respective companies.

e The screen displays as illustrated in this Owner’s Manual are for instructional purposes, and may
appear somewhat different from the screens which appear on your computer.

e Future upgrades of application and system software and any changes in specifications and
functions will be announced separately.

* Windows® is the registered trademark of Microsoft® Corporation.
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The DME Audio System Network

In an audio system including one or more DME units and/or SP2060 units, the “control space” is
logically organized using the concepts of “Area”, “Zone”, and “Device Group”. The space covered by
the entire system is the “Area”, while independent sonic spaces within that Area are called “Zone” A
group of DME or SP2060 units assigned to the same function are considered a “Device Group”.

An Area is comprised of one or more Zones, and each Zone can include up to 32 Device Groups.

A single Device Group can include as many as 16 devices. Each Device Group has one “Group
Master”.

Meter response may deteriorate as the number of meters displayed in a single device group in DME Designer increases. In
such cases meter response can be improved by dividing the device group.
See “Changing Device Groups” on page 283.

DME and SP2060 units cannot be combined in the same Device Group.

All devices in a Device Group must be on the same subnet.
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The DME Designer Software Application

The DME Designer software application provides a convenient, central interface for the creation and
control of DME-based audio systems.

By connecting the computer on which the DME Designer application is running to a Group Master it
becomes possible to control multiple devices simultaneously.

With DME Designer, DME audio systems can be designed and configured via a comprehensive block-
diagram interface on the computer screen.

= DME Designer -

m 8 oo Ty b
(=W AT RO T
r— sy | Device Group

User x

Mute Rx

B Ducking
B Expander
PGiate
EiLimiter
BEQ
BGEQ
£ BPEQ
-Eabona
E-ESteren
82 Bard
£3 Band
-4 Band
5 Bard
£5 Band

B Fader
EFesdback Suppressor
EFilter
EMeter
&1 Channel
82 Channel
.. 4 Chanrel
29 Channel
12 Channel
. 16 Charrel
EMiscellaneaus
EMier
Béute Mier
£ EiDelay Matrix
B2 hput
=B Input
i #2 Output
B4 Output
-8 Output
12 Output
i -E16 Output
-8 Iput

L bt Mivar

The main concepts used in the creation of DME audio systems are “Components”, “Configurations”,
“Preset Parameters”, and “Scenes”.

B Components

Any independent signal-processing block, such as an equalizer, compressor,
input/output module, or external device control object is a “Component”.

B Configurations
A “Configuration” is group of components, including their placement and interconnections.
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B Preset Parameters

The set of parameters for all components in a Configuration is know as the Configuration's “Preset
Parameters”.

B Scenes
A Configuration and its Preset Parameters are a “Scene”.

Composition of scene
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DME settings as well as Configuration and Preset Parameter settings are sent from the DME Designer
application running on the computer to the Device Master via USB or Ethernet, allowing each device

to function as a separate processor, independently from the computer. It is also possible to keep the

DME Designer application on line and control the devices in real time.

It is possible to use the DME Designer to create Configurations that include multiple devices when the
appropriate devices are connected.

Although it is possible to have multiple Zones in an Area, multiple Device Groups in a Zone, and
multiple Scenes and Configurations in a Device Group, only one Area, Zone, Device Group and
Configuration can be active and editable via the DME Designer at any one time. The active elements
are known as the Current Zone, Current Device Group, Current Scene, and Current Configuration.
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Data Handled by a DME Audio System

B DME Data Structure

Common Overall Data

Scene Link Settings

Settings required for linked scene operation between multiple
groups.

Data for Each Device Group

User Defined Button Settings

Settings required for component parameter control from the
DMEBAN/DME24N or ICP1 panel.
Up to 24 parameters can be registered for control.

Global Parameter Link Settings

Settings required for linked operation of the same types of
parameters between multiple devices.

Data Used by the Scene Manager

MIDI program Change Settings

Settings required to allow scene selection via MIDI commands.

Scenes

The information required to switch audio data processing
setups.

Scenes include configurations and preset data.

The Scene Manager facilitates registration and management of
scene data.

Up to 999 scenes can be registered, and registered scenes are
managed by their scene numbers.

Data for Each Device

Configurations

A combination of the audio signal processing, audio input/
output, and external device control components and their
interconnections, created to create the desired audio system.

Local Parameter Link
Settings

Settings that allow linked operation between similar types of
internal DME parameters.

Component Link
Settings

Settings that allow linked operation between similar types of
internal DME components.

External Device
Settings

Settings required to allow control of component parameters from
external devices.

Independent settings are required for each device.

The external devices that can be used are as follows:

e MIDI Controller (MIDI Control Change, Parameter Change).

e GPI Controller.

e DAW Controller.

e AMX, Crestron, and other remote controllers.

e PM5D or other compatible mixing console (controlling DME
internal head amp)

Preset Parameters

The settings for the components in a configuration.

Audio processing setups can be switched by changing the
preset parameters.

Components included in the preset parameter set are as
follows:

e GEQ, MatrixMixer, and other audio signal processing
components.

e Internal AD/DA (DME24N), Cascade (DME64N), and MY card
I/O components*.

e Components for external devices such as the AD8HR and
AD824 remote head amplifiers.

* Some settings not included.
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B SP2060 Data Structure

Common Overall Data

Scene Link Settings

Settings required for linked scene operation between multiple devices.

Data for Each Device

Scenes

The information required to switch audio data processing setups.

Scenes include configurations and preset data, The last Library name recalled is
specified.

The Scene Manager facilitates registration and management of scene data.

Up to 99 scenes can be registered for 12 preset areas and 87 user areas, and reg-
istered scenes are managed by their scene numbers.

Configurations

A combination of the audio signal processing, audio input/output, and external
device control components and their interconnections, created to create the
desired audio system.

Local Parameter Link
Settings

Settings that allow linked operation between similar types of internal SP2060
parameters.

Preset Parameters

The settings for the components in a configuration.
Audio processing setups can be switched by changing the preset parameters.
Preset parameters can be recalled by SP2060 units, but not edited.

Data for Each Component

Library

Settings specific to the speakers to be used.
In addition to the preset data provided, settings can be created by the DME
Designer.
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Separate SP2060 units normally handle scenes independently, but the Scene Link function can be set from the DME
Designer to allow linked scene operation. See “Scene Link Manager” on page 146.

System Requirement

Operating System

Windows® XP Professional/XP Home Edition/2000 Professional

CPU

1 GHz or better Intel® Core™/Pentium®/Celeron® family processor

Memory

256 MB or more

Hard Disk Capacity

300 MB or more

Display

1,280 x 1,024 pixels or better/High Color 16 bit or better

Other

Mouse, CD-ROM drive, 100Base-TX/10Base-T Ethernet or USB connection
environment.

Operating System

Windows® Vista Ultimate/Business/Enterprise

CPU

1.4 GHz or better Intel® Core™/Pentium®/Celeron® family processor

Memory

1 GB or more

Hard Disk Capacity

300 MB or more

Display

1,280 x 1,024 pixels or better/High Color 16 bit or better

Other

Mouse, CD-ROM drive, 100Base-TX/10Base-T Ethernet or USB connection
environment.

Operating System

Windows® 7 Ultimate/Professional

CPU

1.4 GHz or better Intel® Core™/Pentium®/Celeron® family processor

Memory

1 GB or more

Hard Disk Capacity

300 MB or more

Display

1,280 x 1,024 pixels or better/High Color 16 bit or better

Other

Mouse, CD-ROM drive, 100Base-TX/10Base-T Ethernet or USB connection
environment.

The system requirements described above are applied to the DME Designer version 3.5.1. Keep in mind that the software is
often updated and the system requirements are subject to change. You can check the latest version information and its
system requirements at the following website.

http://www.yamahaproaudio.com/

The system requirements may differ slightly depending on the particular computer.
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Main Changes from V1.0 to V1.1

B Main Panel Window

e Instead of the former Parameter Link function, there are now two functions: a Global Link function
that links parameters within all DMEs in a zone and a Local Link function that links parameters
within a single DME unit. (page 90)

e The Synchronization function can now not only send data from DME Designer to the DME unit,
but can also synchronize by reading data from the DME unit. (page 92)

e Scene Increment/Decrement and Time Adjustment can now be assigned in the GPI input
function. (page 109)

e DME unit events can now be recorded by the Event Logger function and displayed in the Event
Logger window. (page 169)

e The time for executing an event can now be set by using the Event Scheduler function.
(page 134)

e Parameters in the current configuration can now be listed on the display and printed out by using
the Parameter List function. (page 139)

e The Wav File Manager can manage Wave files played by the Wav File Player. (page 146)

e Settings can be made by the DAW Control function that are used for controlling DMEs from a
DAW controller. (page 152)

e DME unit data can now be saved as a backup file by using the Backup function. (page 152)

B Designer Window

e The port name display can now be switched between long name display and short name display.
(page 197)

e DMEB4N cascade connections can now be set. (page 212)

e Priority items can now be set when compiling configurations by using the [Compile Priority]
function in the “Preferences” dialog box. (page 211)

e Delay time can now be displayed for each component by using the Show Signal Delay function.
(page 295)

e Monitoring points can now be edited by using the “Monitoring Point List” dialog box. (page 296)

e The status of connections in a configuration can now be analyzed in advance by using the
Analyze function, without connecting the DME unit. (page 298)

¢ You can now set the action that occurs when you double-click a user module object. You can also
turn user module security ON or OFF, and set a password. (page 299)

e Libraries with component parameters saved in them can now be recalled from the context menu
for a component object. (page 356)

e A new rule for wiring prohibits connections to terminals that would short the terminator.

B Component Editor/Component

e A status bar has been added to the component editor. It displays the component name,
component ID, and parameter IDs for parameters that are being edited. (page 310)

e A Snap function has been added that records parameters in the editor temporarily. Parameter
sets can then be switched by using the Snap buttons. (page 352)

e The meter's peak hold function can now be turned ON or OFF. (page 349)
e A Wav File Player component has been added for playing Wave files. (page 420)

e An effect component called SPX has been added that supports many different effect
applications, such as reverb, delay, and modulation effects, along with complex combinations of
multiple effects. (page 461)

e A Slot Out component editor has been added. (page 473)

e An Undo/Redo function is now available when using the design mode. It can undo the most
recent operation (control movement/resize/deletion).
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Changes from V1.1 to V1.2

B Main Panel Window

¢ The synchronization algorithm has been refined for faster synchronization.

e Synchronization now can be executed from DME to DME Designer without any break in the
sound.

¢ |n the following cases, synchronization can be executed from DME Designer to DME without any
break in the sound:

The second or later synchronization after starting DME Designer* and when differences in data
between the DME and DME Designer are limited to parameters within components, AD824/
AD8HR/DME24N AD/DA setting data, or MY card setting parameters.

* If the file was saved when DME Designer was closed, there will be no break in sound even in the first
synchronization after saving.

e Compile speed has been increased.
Up to three times faster when AutoDelayCompensation is turned On.
Up to two times faster when AutoDelayCompensation is turned Off.

e Synchronization is possible when no MY card or a different MY card is installed in the DME unit
(a confirmation dialog will appear).

¢ An option to automatically close the dialog after synchronization has been added. (page 50)
e A progress bar has been added to the Synchronization dialog. (page 49)
e A message appears to warn when synchronization will cause muting.
¢ The following operations can be performed while on line:
- Scene storage.
- Scene name changes.
- Fade ON/OFF and Fade Mode changes.
- Fade time changes.
- Parameter link setting changes.
* When a scene store is executed, that scene becomes the current scene.
e Wave files can be saved as DME data files, and are included in import/export operations.
(page 42)
e Wave files can be saved in the Wav file library.
e Event Log events can be output via GPI. (page 77)
e The on-line indicator appears as a button which can be used to switch between on-line and
off-line. (page 57)
e Scene edits cause the EDIT indicator to appear. (page 55)
e An auto file save function (Auto Save, post synchronization) has been added. (page 71)
e Different zones can be specified for use by different users. (page 153)

e Scene parameters related to User Defined Button, Program Change, GPI In and GPI Out can be
set via the Scene Manager. (page 80)

e [Select All] and [Clear All] buttons have been added to the Scene Manager Recall Safe dialog.
(page 84)
e User Control can be created for individual users as well as security levels. (page 87)

e A Remote Control Setup List has been added. (page 134)

This list can be used to make detailed settings for a new software protocol that allow the DME to
be controlled from AMX, Crestron, and similar devices.

Refer to the “DME-N Remote Control Protocol Specifications” document for details about the
communication protocol. Information about the “DME-N Remote Control Protocol Specifications”
document can be found at the Yamaha pro Audio website (URL below).

http://www.yamahaproaudio.com/

e |t is possible to specify whether listed events will be executed by the Event Scheduler.
(page 134)
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e The order of same-time events can be changed in the Event Scheduler. (page 134)

e Exceptions can be specified for Event Scheduler execution day/time. (page 102)

e Event Scheduler execution times can be specified in 1-second increments. (page 101)

e Head amp gain and MY-Card can be set via GPI, MIDI, User defined Button, DAW Control.

e Parameter values, scene recall, GPI output, Wave file playback, and head amp gain can be set
via the User Defined Buttons. (page 127)

e The Component Lock function dialog is separate from the Parameter List dialog. (page 145)
e Shortcuts can be freely set as required. (page 151)

e Files can be saved in the DME unit. (page 68)

e A [Close All Editor Windows] button has been added to the Window menu. (page 67)

e External head amp parameters will be recognized by the DME unit when either the DME or the
external head amp (AD824, AD8HR) are turned on. Execute a scene recall to send DME settings
an external head amp.

e This manual is now separate from the DME Designer installer, and can not be accessed from the
DME Designer menus.

B Designer Window

e The following operations can be carried out via the shortcut keys.
- Navigator
- Activate Navigator
- Activate Toolkit
- Activate Design Window
- Select Left Port and Start Wiring
- Select Right Port and Start Wiring
- Wire Auto Single to Right
- Wire Auto Multi to Right
- Wire Auto Single to Left
- Wire Auto Multi to Left
- Delete Wire
e |t is now possible to simultaneously edit multiple objects of the same type.
Example: Change the thickness or color of multiple wires at once.

e Files related to user modules (user module files, library files, user module editor files) can be
combined and exported/imported as a single file.

e Port colors can be independently specified for each port type. (page 201)

e Default wire thicknesses and types can be independently specified for each port type.
e An automatic hot-spot connection function has been added. (page 275)

e Port display has been added to External Device, Picture, DME, and ICP1 objects.

e \When drawing wires the keyboard cursor keys can be used to move the mouse cursor, and the
<Enter> key can be used to create nodes.

e When drawing wires <Shift> key plus <—> key and <Shift> key plus <«> key combinations can
be used to automatically connect horizontally-aligned hot spots.

e DME object ports can be freely specified.

e Compilation of configurations with loop connections is possible when Auto Delay Compensation
is On.

e The name has been changed from “Foot Monitor” external device to “Floor Monitor.”

e Addition External Device types have been provided.

e External Devices can be double-clicked to open a file saved by other applications. (page 224)
e Picture objects can be double-clicked to open a specified editor. (page 240)

e Text objects can be double-clicked to open a specified editor. (page 243)
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e User module port labels can be edited. (page 237)
e Graphics can be placed to represent user modules. (page 236)

e The Legend field automatically resizes to accommodate project names and titles of different
lengths.

e A Generic “MY-Others” setting has been provided to accommodate third-party MY cards.

B Component Editor Window
¢ Undo and Redo are now shortcut compatible.
e A scroll bar appears when the size of the component editor window is reduced.
¢ The size and position of the component editor window are memorized.
e An option to allow mouse-over zooming of the edit box has been added. (page 313)

e A [Back] button that allows switching between related parent and child windows has been
added. (page 310)

e A [Close All Editor Windows] button has been added to the contextual menu.

e Source Selector, Speaker Processor, Limiter, Slot In, Cascade In, and Cascade Out components
have been added.

e The Delay algorithm has been revised. (page 389)
- LEVEL and MUTE are effective when Delay is Off for each channel.
- The name of the overall Delay [On] parameter has been changed to [All Bypass].

Input  Input Input Input
Mgte Level On Mute Level

Mute Level On Mute Level
e o T e

e The bus send level range for Delay, Matrix, and Matrix Mixer components has been changed to
-oo through 0.0 dB.

e Snap copy is possible. (page 353)
e Snap can be retained until the application is quit or another file is opened.
e Security status is displayed in the user module editor status bar.

e Multiple controllers can be selected by clicking while holding the <Ctrl> key when the editor is in
the design mode. (page 348)

e [Picture], [Text], [Box], [Ellipse], and [Frame] have been added to the tool palette of the user
module editor and user control editor design mode. (page 315)

e Controller properties can be accessed by double-clicking controllers in the user module editor or
user control editor design mode. (page 334)

e Picture and Text objects can be clicked to open a specified editor in the user module editor or
user control editor.

e The User Module Editor and User Control Editor offer a greater range of customization options for
color, size. etc., of the placed controls.

B MIDI Setup

e A MIDI Setup minimize function has been added.

B V1.2 Precautions

e When using project files (*.daf) created by version 1.1.5 or earlier, synchronize from the DME
Designer to the DME unit for the first synchronization.

e Project files (*.daf) created using version 1.2 will not open properly on version 1.1.
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Changes from V1.2 to V2.0

B General

e Support added for DMES8i-C/DME80o-C/DME4io-C, SP2060 units and MY 16-ClII.

e “Device Groups”, or groups of the same type of device, have been added at the lowest Zone
level.

e |tis now possible to have one master device per device group rather than one master device per
zone. This means that it is possible to have multiple master devices in a single zone.

e Group masters can now be assigned regardless of the IP address. This makes it possible to have
multiple device groups at a single network address.

e Configurations can be created and deleted for each device group.

B Component

e A Feedback Suppressor component has been added. (page 409)
® The Speaker Processor component PEQ “Q” parameter now goes to “63”. (page 454)

B Main Panel Window

e Firmware and component data can now be updated simultaneously. (page 178)

e A Recovery Update function that allows recovery from program corruption has been added.
(page 180)

e A Component Link function that allows simultaneous linking of all component parameters has
been added. (page 90)

e Scene Link function that allows simultaneous control of multiple devices in different device
groups has been added. (page 146)

e A Protect function has been added to the scene manager. (page 80)

e Card settings are no longer included in scene data.

e A Ultility window has been added to allow editing of device utility settings. (page 162)

e The Local Parameter Link display order has been changed. (page 90)

e Parameter Link operation can now be turned on or off for each device group. (page 90)
e Compilation and analysis is now possible even if no connections have been made.

e Navigator window hide/show can now be selected from the main window.

e The Event Logger can now display only the event data for a specified device. (page 73)
e The GPI terminal names have been changed from [CH] to [PORT].

B Designer Window

¢ A hand tool for window movement has been added. The hand tool can be selected via the hand/
arrow icon in the toolbar, or from the [Tools] menu. The hand tool can also be temporarily
selected by holding the spacebar on your keyboard.

¢ Window magnification and reduction can now be controlled via the mouse wheel while holding
the keyboard “Ctrl” key.

e Horizontal scrolling can be controlled via the mouse wheel while holding the keyboard “Shift” key.
¢ The Edit Mode on/off can now be changed from the tool bar. (page 183)

e Scene information now appears in DME objects, and the Scene Manager can be launched from
the scene information display. (page 80)

¢ An [On-line] button has been added to DME objects, and synchronization is now possible.
(page 57)
e Sampling frequency display has been added to the resource meter window. (page 187)
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e Sampling frequency display has been added to the configuration window status bar. (page 291)
e The sampling frequency is now displayed during analysis.

e Double-clicking the component name now opens the properties window.

e Organization of the Tool Kit window has been changed. (page 189)

e A [Draw Image] checkbox that displays or hides the worksheet background image file has been
added to the Sheet properties. (page 204)

e [Configuration Manager] has been added to the contextual menu that appears when a DME or
SP2060 object is right-clicked. (page 208,page 217)

e [Recall Component Library] and [Store Component Library] now appear in the contextual menu
that appears when a component is right-clicked, even when the Edit Mode is OFF.

e The Compile Settings can now be edited for each DME unit. (page 211)
e Only one Zone window is now provided for multiple configurations.

e The [Export DXF] and [Preferences] commands have been moved from the [Print] menu to the
[Tools] menu.

¢ [Configuration] has been changed to [Configuration Manager] in the [Tools] menu.

e When [Prohibit Diagonal Connections] in the [Tools] menu is active it is possible to select 2
diagonal points and those points will automatically be connected by a combination of horizontal
and vertical wires.

B Component Editor Window

e A [Level Meter Enable] command that displays or hides the meter values has been added to the
contextual menu. Hiding the meters can result in increased communication speed in some
cases. (page 350)

e A [Display Order] function that allows the order of the controllers to be changed as required has
been added to the User Control Editor and User Module Editor. (page 315)

e An [Add Component to Component Link] command has been added to the controller contextual
menu.(page 360)

e The registered group is now displayed in the [Add Parameter to Parameter Link] submenu of the
contextual menu of controllers registered for Parameter Link operation.(page 358)

e Increased speed when selecting and dragging a large number of controllers in the User Control
Editor and User Module Editor

e |t is now possible to switch from the Navigator window to Zone display while online.

B V2.0 Precautions
Please use DME Designer V2.0 with DME64N/24N V2.0 or higher, DME8i-C/DME80o-C/DME4io-C
V2.0 or higher, and SP2060 V1.1 or higher.
See the Yamaha Pro Audio website for compatibility details (http://www.yamahaproaudio.com/).
When DMEB4N/24N and DMES8i-C/DME80o-C/DME4io-C are used together in the same device
group, faster communication speed as well as smoother DME Designer meter display can be
obtained by assigning a DMES8i-C/DME8o-C/DME4io-C unit as the device group master.
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Changes from V2.0 to V3.0

B General

e DMES8i-ES/DME80-ES/DME4io-ES support.

e The DME Designer and DME-N Network Driver installers have been combined, so the
appropriate DME-N Network Driver version is now installed automatically with the DME Designer
application.

e The following connections to the Slave DME units are now possible when a DME Satellite unit is
assigned as the Device Group Master:

- USB/Ethernet connection to the computer (DME Designer).
- Cascade connection to control from the PM5D console (DME64N only).

B Component

e Ambient Noise Compensator component added (page 369).
e Audio Detector component added (page 371).

e Auto Gain Control component added (page 372).

e Auto Mixer Il component added (page 421).

e Simple Mixer component added (page 440).

e Room Combiner component added (page 450).

e Matrix Mixer and Router component variations added.

B Main Panel Window

¢ To allow project information to be easily reproduced on a different computer, it is now possible to
export and import all necessary files at once, rather than only project files with the “.daf”
extension (page 43).

¢ A Device Information window that lists the status of all devices has been added (page 181).

e |t is now possible to individually set each user control to determine whether it will open
automatically when the project file is opened (page 87).

e In accordance with the above change, the Startup User Control item has been removed from the
Security dialog box.

e |t is now possible to assign Direct Parameter Value to the GPI input function, and assign Direct
Parameter Value and Audio Detector to the GPI output function (page 107, page 117).

e An option that automatically saves the project file (.daf extension) in the DME unit when going
online has been added (page 93).

e |t is now possible to control internal DME-24N/DMES8i-C/DME4io-C/DMES8I-ES/DME4io-ES head
amps from a PM5D or other compatible mixing console (page 136).

e Remote control from AMX, Crestron, and similar controllers is now possible via Ethernet
connection only for DME Satellite units. (page 166).

e The display format of the parameter values displayed in the Remote Control Setup List and
Parameter List dialog box can now be switched between the internal settings and the values
displayed in the editor windows (page 134, page 142).

e The Event Logger window can now display additional error messages shown on the DME display
panel (page 78).

e |t is now possible to set the DME unit so that the internally stored event log is not erased
(page 75).

¢ Improvements have been made to the additional error message information shown in the Event
Logger window.

e The DME unit internal clock and DME Designer time display how support daylight saving time
(DST) (page 172).

e Firmware updates can now be applied to entire device groups, for improved speed and
efficiency.
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B Designer Window

e |t is now possible to set a “clear” background color for text, box, and ellipse objects (page 243,
page 245, page 247).

e Password entry is now required when opening a User Module Properties dialog box or saving/
exporting in a user module to which security has been applied.

e Linked software applications can now be launched from the Slot component contextual menu
(page 231).

e User module templates that use the same library are now categorized and displayed as user
module groups (page 300).

¢ Image files are now included in User Module exports.

e Component and parameter links can now be copied when DME objects, components, and user
modules are copied/pasted or duplicated.

e Parameter links are now saved when User Module data is saved/exported.

e \When already-placed picture files are replaced, they will be updated and displayed correctly
without the need to restart the DME Designer application.

B Component Editor Window

e [Line] and [Scene Recall] tools have been added to the User Module Editor and User Control
Editor design modes, allowing placement of lines and scene recall buttons (page 322).

¢ |n the User Module Editor and User Control Editor it is now possible to convert placed sliders to
knobs, and vice-versa (page 333).
¢ More options are available for customizing the controls listed below in the User Module Editor
and User Control Editor:
- A property dialog box has been added for sliders, allowing customization of direction, scale,
color, size, and other parameters (page 335).
- Level meter size can be customized (page 337).
- A property dialog box has been added for slider level meters, allowing customization of
direction and size (page 338).
- Knob color and knob background color can be customized (page 334).
- Text background color can be customized (page 342).
- A property dialog box has been added for indicators, allowing customization of color and size
(page 338).

Bl V3.0 Precautions

Use DME Designer V3.0 only with DME64N/24N V3.0 or higher, DME Satellite V3.0 or higher, and/or
SP2060 V1.2 or higher. Refer to the Yamaha Pro Audio website (http://www.yamahaproaudio.com/)
details on combinations.

When combining DME64N/24N and DME Satellite units in a device group, be sure to assign a DME
Satellite unit as the device group master. Synchronization cannot be performed if a DMEG4N/24N is
assigned as the device group master.

When using the Windows Vista operating system, use only USB-MIDI Driver V3.0 or higher, and
DME-N Network Driver V1.2 or higher.
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Changes from V3.0 to V3.5

B Component
e Program Ducker component added (page 402).

e (V3.5.1) During installation it is possible to select and install speaker library data for third-part
speakers into the Speaker Processor component library.

B Main Panel Window
e MIDI Setup has been discontinued. Communication ports can now be directly selected via the
[Setup] menu [Communication Port] item. (page 150)

¢ (V3.5.1) [SP2060 Backup] has been added to the main panel window [Hardware] menu, allowing
internal SP2060 data to be transferred to a computer for backup. Multiple SP2060 units can be
restored from the backup data. (page 176)

B Designer Window
e Improvements in the compiler algorithm achieve greater DSP resource utilization efficiency.
(page 93, page 295, page 298)
e MY16-ES64, MY16-EX, and MY16-MD64 1/O cards can now be specified for slot installation.

e The TX6n/TX5n/TX4n, ACD1, SB168-ES, IMX644, IPA8200, and NEXO products can now be
specified as external devices. V3.5.1 adds the IM8, MSR250, and other devices.

¢ \When cascade connecting DMEB4N units across device groups, unit numbers are automatically

assigned when a connection is made between the [CAS IN] and [CAS OUT] terminals in the
Zone window.

B Others (Firmware V3.09 changes)

e \When controlling DME units remotely from a PM5D using the DME Control function, it is now
possible to set an ID number other than “2” for the group master DME unit. In this case the PM5D
firmware must be updated to V2.20 or higher.

e |t is now possible to replace the default DME64N/24N startup screen (normally the model name)
with an original graphic file. (page 69)

Bl V3.5 Precautions

Use DME Designer V3.5 only with DME64N/24N V3.0 or higher, DME Satellite V3.0 or higher, and/or
SP2060 V1.2 or higher. Refer to the Yamaha Pro Audio website (http://www.yamahaproaudio.com/)
details on combinations.

When combining DME64N/24N and DME Satellite units in a device group, be sure to assign a DME
Satellite unit as the device group master. Synchronization cannot be performed if a DMEG4N/24N is
assigned as the device group master.

When using the Windows Vista operating system, use only USB-MIDI Driver V3.0 or higher, and
DME-N Network Driver V1.2 or higher.

When using the Windows 7 operating system, use only USB-MIDI Driver V3.0.4 or higher, and
DME-N Network Driver V1.2.1 or higher.
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Chapter 1 Before Using

Installing DME Designer

To use DME Designer, you must first install the software on the computer. Before you can connect the
DME Designer software to the DME or SP2060 unit, you must first install the USB MIDI Driver or the
DME-N Network Driver, according to how you will be connecting, and then make the appropriate
settings.

For instructions about the installation and setup for the DME Designer and DME-N Network Driver, and
about the installation for the USB-MIDI Driver, see the “DME Setup Manual.”

Initial settings for DME Satellite units must be transferred via USB-MIDI, so it is necessary to properly install the USB-MIDI
Driver.

Starting DME Designer

The DME Designer software is started from the [Start] menu. DME Designer is used with one user
logged on. The user logs on when the software is started.

B DME Designer Start Up and Logon (When Auto-Logon Is Not Set)

1 Click [Start] — [All Programs] = [YAMAHA OPT Tools] = [DME Designer] = [DME
Designer].

In Windows2000, click [Start] — [Programs] — [YAMAHA OPT Tools] — [DME Designer] — [DME Designer].

The “Log On” dialog box will be displayed.

Llzer ] Adrninistrator :J

FPazzward ]

Enit

Automatic log-on is the default setting. If the automatic logon feature is enabled, the “Log On” dialog box will not be
displayed when the application is started. Instead, the auto-logon user will be logged on automatically. See page 29
for information about auto-logon.
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2 Click the [¥] at the right of the [User] box, and select the user.

If no user has been created, only [Administrator] will appear in the list. When starting DME
Designer for the first time after installing, select [Administrator].

3 Enter the password into the [Password] box.

Enter the password set for the user.
If no password has been set, leave the password box blank when you log on.

4 Click the [OK] button.
DME Designer starts up.

™% DME Desiener -

&

M8 el T ::ﬂ Zone

5 -2 || Device Group
cene ] F

&

", Mavigator
e B Area
BExternal Device
-Picture
Text

Box
-Ellipse

B When Automatic Logon Has Been Set (page 29)

If automatic logon has been set, the “Log On” dialog box will not be displayed. The user set for
automatic logon will be logged on.

With automatic log on, even if a password is set for a user, it will not be requested during log on.
This is useful when logging on a specific user.

B Starting by Opening a Project File
DME Designer starts when a project file with a saved configuration is opened. When the project file
is opened, DME Designer is started with the window configuration that was in place when the file
was last saved.
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Closing DME Designer

To close DME Designer, click [Exit] on the [File] menu of the Main Panel window. It can also be closed
by clicking the [Close] button on the Main Panel window.

1 Click [Exit] on the Main Panel window [File] menu.
When you try to close DME Designer, “Project File has been modified. Save?” will be displayed in a
dialog box.

Sometimes the “Project File has been modified. Save?” dialog box will not be displayed.

DME Designer

i Project file has been modified.
' Save?

Yes Mo |

2 To save the file, click [Yes]. To close without saving, click [NOo].
If you click [Yes], the File Save dialog box will be displayed.
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Chapter 2 DME Designer Overview

Names and Functions of the Windows

The DME Designer software has several windows, including the Main Panel window, Designer window,
Component Editor window, Resource Meter window, and others.

Main Panel Window Component Editor Window

Compressor
Campressorl)

Designer Window Resource Meter Window

Main Panel Window

Menus and buttons are available in the Main Panel window. The current DME Designer environment,
including the active zone, device group and scene the currently logged on user name, and the
connection status to the DME unit are displayed on the right side of the Main Panel window.
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Chapter 2 DME Designer Overview

Designer Window

The Designer window displays several different windows. First among them is the Area window, where
you can manage the entire system. The Area window includes one or more Zone windows, which in
turn include one or more DME or SP2060 units that are used to build a zones within the area. Next is
the Configuration window, where you create the internal configuration of each DME or SP2060 unit.
Within the Configuration window are the User Module windows, where you can assemble often-used
components into templates the Toolkit window, which displays objects used in the other windows as
the basic building blocks for sound designs; and the Navigator window, which lets you grasp the
overall status of the system at a glance.

Zone Window Configuration Window Navigator Window

Toolkit Window User Module Window

B Area Window

The Area window is used for designing areas, which manage the entire system. While at least one
zone is included within an area, multiple zones can be arranged there.

.-'r«.w Area .

x
......................................... =

Zones
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Chapter 2 DME Designer Overview

B Zone Window

The Zone window is used to design zones within the area. A zone is a more concrete blueprint that
includes at least one DME or SP2060. It shows the DME’s connections with other devices and the
wiring between them. You can create multiple zones.

The DME and SP2060 units and connected devices are arranged in each Zone window, creating
configurations.

Configurations

I

B Configuration Window

The Configuration window is used to design the internal configuration of each DME unit contained
in the Zone window. By arranging and connecting components in the Configuration window, you
can create things like complex processors or matrix mixers, that determine the actual internal
structure that operates each DME unit.

i |DMEB4N(Tone1)

Components

Bl User Module Window

The User Module window is used for designing user modules that can be arranged in the
Configuration window. You can create original modules by combining multiple examples of often-

used components. When you save these modules as templates you can recall them easily
whenever you want.

. Unsaved User Madube(Zone)
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Chapter 2 DME Designer Overview

Bl Toolkit Window

The Toolkit window displays the objects that you can use in each window that can be displayed in
the Designer window. Those windows are the Area, Zone, Configuration, and User Module
windows. The Toolkit displays different objects, according to the currently active window. To place
an object in a window, double-click it in the Toolkit window where it is displayed or drag it to the
currently active window.

B Navigator Window

The Navigator window displays the area, zones, configurations, and components in a hierarchal
fashion that lets you check their status as a whole. When editing offline, you can click an area
name, zone name, or configuration name to make that window active. Clicking a component name
will open the component editor window for that component.

B Resource Meter Window

This window provides an indication of component usage for each DME unit currently placed in the
Configuration window. The usage percentage increases as the number of components increases. The
component usage percentage is shown in graph form for each DME unit.

The window appears simultaneously with the designer window, and can be used as a component
usage guide while creating configurations. The sampling frequency for each DME unit is also
displayed. Please note that the sampling frequency of the DME unit itself will also affect the usage
percentage.

In configurations that have a large number of connections, compilation might not be possible in some cases even if the
resource meter reading is less than 100%. To determine whether compilation is possible we recommend using the “Analyze”
dialog box (page 298) prior to actual compilation.

This window is not displayed for SP2060 units.

" ResourceMe. .. rzl
FS: 48.0kHz

B Objects and Components

“Object” is the name for the parts that are arranged in the various design windows, such as the
Area, Zone, Configuration, and User Module windows. Objects are always laid out in the Toolkit
window. Only the appropriate objects for each window are displayed. The blocks displayed at the
higher level of the Toolkit window in particular are called “components.” This refers to each type of
processor that operates the DME. “Object” normally refers to Picture, Text, Ellipse and other items
that are used after connecting them by wire to the various components.
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Component Editor

The blocks that are arranged in the configuration window are called “components.” When you
double-click on a component block arranged in the Configuration window, the Component Editor
window will open. There you can edit the parameters for that component. The types of parameters
displayed will differ, depending on the component.

i iDMEG4N(Zane1)

Component Editor
(Stereo Compressor)

Component

Window Operations

Operations in all windows are the same as for normal Windows applications. The windows are
controlled with the [Minimize], [Maximize/Restore], and [Close] buttons at the upper right of the title
bar. DME Designer is closed by clicking the [Close] button on the Main Panel window.
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Users and Security

You can create multiple users in DME Designer and set the functions that are available to each user.
Although users who will design and put together installations must be able to use all the functions of
DME Designer, users who will only operate the system can be restricted to functions that will not allow
them to accidentally change the settings.

DME Designer is used with one user at a time logged on. To change the user, click the [File] menu —
[Log Off] command on the Main Panel window.

About Users

To use DME Designer, you must logon when you start the software. Except for the first time the
software is started or when separate settings are made for the first time, you can logon by specifying
the name and password for a user that has been set as the administrator. The administrator can build
the system as a whole, or apply function limitations that let other people edit. Administrators or other
people that can use DME Designer are called “users.” The user name for the currently logged on user
appears below [User] on the Main Panel window.

2 DME Desiener :

== (=Rl T RO BT S

. Scene . Device Group
e |
R L cene ( e[

Currently Logged On User Name

The default user, named [Administrator], is set to use all of the functions. Immediately after DME
Designer is installed, [Administrator] is the only user, and there is no password set.

Multiple users can be created. When the system administrator creates multiple users, restrictions can
be applied separately for each one of them. A user with restrictions applied can edit using only the
functions the administrator enables for him.

The place to create, setup, and delete users is the “Security” dialog box. See “Scene Manager” on
page 80.

Automatic Logging On

With the auto-logon function, you can have a specified user automatically logged on when the
application is started. If you enable the auto-logon feature, the specified user will be logged on when
the application is started, without displaying the “Log On” dialog box.

Auto-logon is set from the “Security” dialog box. See “Scene Manager” on page 80.
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Logging On

The “Log On” dialog box is displayed whenever the application is started or a user is logged off.
Whenever one user is already logged on, another user cannot be logged on. To log on as another
user, first log off the currently logged on user.

Unless you specifically want to restrict access, we recommend enabling automatic logon. If the access password is
forgotten or lost it will not be possible to logon or operate the system.

If the automatic logon feature is enabled, the “Log On” dialog box will not be displayed when the application is started.
Instead, the auto-logon user will be logged on automatically.

B The “Log On” dialog box

o— -[U el | Adrninistrator LJ]

0O— -[F'asswnld | ]

© [User]

From the list, select the user you want to log on as.

@ [Password] Box
Enter the password.

© [OK] Button
Log on as the selected user.

O [Exit] Button
When the application is started, and the “Log On” dialog box is displayed, there is an [EXxit]
button. This closes the application without logging on a user.

© [Cancel] Button
When the “Log On” dialog box is displayed after a user is logged off, there is a [Cancel] button
instead of an [Exit] button. This cancels the logoff. The original user will continue to be logged
on.

B Logon Procedure

1 Click [¥] at the right of the [User].
A drop-down list of user names will be displayed.

2 Click the user you want to log on.

3 Enter the password into the [Password] box.
When you type in the password box, the characters you enter will display as asterisks (*).

4 Click the [OK] button.
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Logging Off

Logoff is used when changing users. When you log off, the document currently being edited is closed,
and the “Log On” dialog box is displayed so you can log on the next user. Log off with the [Log Off]
command on the [File] menu in the Main Panel window.

1 Click the [File] menu — [Log Off] command on the Main Panel window.

= DME Designer :

Mew Chrl+M — -
AT &N :ES

Ir': Cpen... ChrHO
E Save Chrl+5 User &

Save As...

Import DME Designer Al File

Export DME Designer all File

DME File Storage

Import Device Configuration »
Export Device Configuration »
1 C:fSetup0s.daf

2 CifSetup0s. daf

Preferences

Exit

Log on the next user in the “Log On” dialog box.
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32